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Image Viewing, Organizing and Editing Software

ZoomBrowser EX
Ver. 5.8

Instruction Manual

Content of this Instruction Manual
ZB is used for ZoomBrowser EX.
In this manual, the windows used in the 
examples are from Windows XP.
 indicates the selection procedure of the menu.

(Example: [File] menu  [Exit].)
Square brackets are used to indicate items such 
as menu names, button names and window 
names that appear on the computer screen.
Text inside < > indicates a camera switch name 
or icon, or a keyboard key name.
** indicates a reference page.
Click to move to the relevant page.

 : Marks helpful information when a problem 
arises.

 : Marks tips for using the software skillfully.
 : Marks information that should be read 

before use.
 : Marks additional information you may find 

helpful.

© CANON INC. 2007     CT1-7143ZBWE-000

Switching Between Pages
Click on arrows on the bottom right of the screen.

 : next page
 : previous page
 : return to a page you had previously 

displayed
Click on the chapter headings on the right side 
of the screen to switch to the contents page of 
that chapter. Also, click the item you want to 
read about on the table of contents to move to 
the relevant page.

Help
For information about using ZB, refer to the Help 
from the [Help] menu or click the [?] button on 
each window and refer to the Help displayed.
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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM 
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF 
THIS AGREEMENT.
This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). 
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT 
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX 
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM 
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions 
of this Agreement.
1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single 

computer. You may physically transfer the SOFTWARE from one computer to another provided 
that the SOFTWARE is used on only one computer at a time. You shall not install or use the 
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware 
configuration where the SOFTWARE is accessible to more than one CPU or to more than one 
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE, 
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, 
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, 
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.
2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or 

copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer 
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation 
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for 
use of the SOFTWARE. No updates, fixes or support will be made available for the 
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 
maintain and match the hardware and software components of your computer system. Thus 
Canon does not guarantee uninterrupted service or correction of errors or that the functions or 
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED 
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the 
SOFTWARE is warranted only against defective material under normal use for a period of ninety 
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt. 
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge 
when returned by you at your expense to your point of purchase and proven to be defective 
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original 
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if 
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE 
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS 
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, 
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF 
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE 
SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until 

expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may 
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate 
without notice to you if you fail to comply with any of the terms of this Agreement and you must 
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with 
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at 
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software 
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be 
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void 
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in 
the United States of America shall be governed and construed in all respects in accordance with 
the laws and regulations of the State of New York, without reference to choice of law principles. 
The terms of this Agreement as it relates to purchases of the Software in Canada shall be 
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of 
the SOFTWARE is subject to the United States, Canada and other applicable copyright and 
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its 
affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any 
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON 
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS 
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO 
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY 
AUTHORIZED OFFICER OF CANON.
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Introduction
ZoomBrowser EX (hereinafter, “ZB”) is image viewing, organizing and 
editing software for Canon digital cameras. As well as downloading, 
viewing and printing images you have shot with your digital camera, you 
can utilize your images using the software’s various functions.

Main Features of ZB
Download images from your camera to your 
computer
Display a list of images or display 
individual images

Display a list of images in three types of main window
Display individual images in the viewer window

Print images
Print images with Canon inkjet printers
Print one image per page and index print

Organize images
Edit images

Automatically adjust images
Adjust brightness and color
Trim images
Insert text into an image
Adjust sharpness
Correct red-eye

Utilize images
Attach an image to an e-mail
Use an image as wallpaper or a screen saver

System Requirements

*1 Compatible with 32-bit/64-bit systems for all versions except Starter 
Edition

*2 Compatible with Service Pack 2
*3 Compatible with Service Pack 4

Supported Images

OS
Windows Vista*1
Windows XP Professional/Home Edition*2
Windows 2000 Professional*3

Computer PC with one of the above OS preinstalled
* Upgraded machines not supported

CPU Windows Vista 1.3GHz Pentium or higher
Windows XP, 2000 500MHz Pentium or higher

RAM Windows Vista Minimum 512MB
Windows XP, 2000 Minimum 256MB

Display Screen resolution: 1024 × 768 pixels or more
Color quality: Medium (16 bit) or more

Image type/Camera used Extension

JPEG images
JPEG images shot with a Canon digital 
camera (Exif 2.2 or 2.21-compatible 
JPEG images)

.JPG, .JPEG

RAW images

EOS-1D Mark III EOS-1D Mark II N
EOS-1Ds Mark II EOS-1D Mark II
EOS 5D EOS 40D
EOS 30D EOS 20D/20Da
EOS DIGITAL REBEL XTi/400D DIGITAL
EOS DIGITAL REBEL XT/350D DIGITAL

.CR2

EOS-1Ds EOS-1D .TIF
EOS 10D
EOS DIGITAL REBEL/300D DIGITAL
EOS D60 EOS D30

.CRW

TIFF images Exif-compatible TIFF images .TIF, .TIFF
BMP images Bitmap images .BMP
PCD images Photo CD images .PCD
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Contents at a Glance
Downloading Images to Your Computer

Download images by connecting your camera and 
computer  p.5

Download images using a card reader  p.7

Image Display and Checking
Look through the images  p.9
Enlarge and view images  p.11, p.18
Check the images efficiently  p.21
Compare multiple images  p.43
Check the shooting information such as shot date  p.46
View the images as a slide show  p.34

Printing
Print one image on one page  p.15
Print with a Canon printer  p.13
Arrange multiple images on one page and print  p.41

Organizing Images
Sort images (ratings)  p.19
Move images to a different location  p.23
Move images in folders to a different location  p.23
Change the image file name  p.24
Delete images  p.24
Classify images by shot date  p.51
Search for an image  p.52

Image Editing (Adjustment)
Adjust brightness/darkness  p.29
Make the image colors more vivid  p.29
Sharpen the modulation and contrast of colors 
(contrast)  p.29

Use automatic adjustment  p.27
Trim parts of an image (trimming)  p.30
Specify an aspect ratio that matches the size of the 
paper on which an image is to be printed (trimming)  p.30

Make an image sharp (sharpness)  p.32
Insert text in an image  p.31
Correct red-eye  p.33
Merge images  p.56
Adjust RAW images  p.58

Utilizing Images
Attach an image to an e-mail and send  p.35
Make an image your computer wallpaper  p.37
Make an image your computer screen saver  p.38

Converting/Saving Images
Change the image size  p.47
Change the image to a different type  p.47
Convert a RAW image to a JPEG or TIFF image  p.58
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Basic Operation
This chapter explains basic operations such as starting up ZB, 
downloading images from your camera to your computer, viewing, 
checking and printing downloaded images and exiting ZB.

Starting up ZB............................................................  5
Downloading an Image to Your Computer ................  5

Downloading Images Using Your Card Reader............  7
Viewing an Image ......................................................  9

View Images as Thumbnails in the Main Window ........  9
Enlarging a Selected Folder ................................... 10
Changing the Display Magnification ....................... 11

Enlarging and Viewing Images One at a Time ........... 11
Displaying an Image Across the Whole Window (Full 
View Display).......................................................... 12

Printing an Image ....................................................  13
Photo Printing with Canon Inkjet Printers ................... 13
Photo Printing with a Printer other than Canon Inkjet 
Printers ....................................................................... 15

Exiting ZB ................................................................  16
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Starting up ZB
Double-click the desktop icon.

ZB starts up and the main window appears.

Double-click

Main window

Downloading an Image to Your Computer
Connect the camera and computer with the cable provided and 
download the images saved on the memory card inside the camera.
For downloading images, start up the camera software “EOS Utility” 
from ZB and use.

1 Select the save destination for the images.

When creating a folder, refer to p.22.

Click to display the [All 
Folders] tab sheet

Click
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2 Start up EOS Utility.
Click the buttons [Acquire & Camera Settings]  [Connect to 
EOS Camera].

EOS Utility starts up.

EOS Utility

3 Connect your camera and computer and turn the 
camera on.

Connect the camera and your computer with the interface cable 
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and 
computer, refer to the “EOS Utility Instruction Manual” (PDF 
electronic manual).

When the dialog box below appears, select [Canon EOS Utility] 
and then click the [OK] button.
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4 Download images.

Downloading of images begins.
The downloaded images are saved in the folder selected in step 
1 and are displayed in the main window of ZB.
The downloaded images are sorted into folders by date and 
saved.
Click the EOS Utility [Quit] button to exit EOS Utility and turn the 
camera’s power switch to < OFF >.

Click

Using EOS Utility to download images makes it easier to organize your 
images as they are downloaded, sorted and saved into folders by date.

Advantages of using EOS Utility to download images

You can also download images to the computer using a third-party card 
reader. For downloading images, start up the memory card software 
“CameraWindow MC” from ZB and use.

1 Select the save destination for the images (p.5).

2 Load the memory card into the card reader.

When the dialog box below appears, select [using Canon 
CameraWindow] and then click the [OK] button. CameraWindow 
MC starts up.

Proceed to step 4.

Downloading Images Using Your Card Reader
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3 Start up CameraWindow MC.
Click the buttons [Acquire & Camera Settings]  [Acquire 
Images from Memory Card].

CameraWindow MC starts up.

4 Download images.

Downloading of images begins.
The downloaded images are saved in the folder selected in step 
1 and are displayed in the main window of ZB.
The downloaded images are sorted into folders by date and 
saved.
Click the CameraWindow MC [Finish] button to exit 
CameraWindow MC.

Click

CameraWindow MC

Using CameraWindow MC to download images makes it easier to 
organize your images as they are downloaded, sorted and saved into 
folders by date.

Advantages of using CameraWindow MC to download images
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Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list 
in the main window. You can double-click an image to open the viewer 
window and display the image at a larger size.

To select multiple images, click on the images while holding 
down the < Ctrl > key on the keyboard.

View Images as Thumbnails in the Main Window

Main window
Click to select the image Rotate selected image

Display thumbnails of all the 
images inside the folder selected 
in the folder area on the left

Move the cursor over the image with the 
mouse and you can check images that 
are displayed in the simple display 
window (mouse over window).
To deactivate simple display, click on 
[ ] on the top of the window, select 
[Show Mouse Over Windows] from the 
menu and remove the check mark.

Simple Display Function

For a list of the main window functions, refer to p.71.

Simple display window
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Enlarging a Selected Folder
Images downloaded to your computer are displayed in folders in the 
main window. Double-click on an empty part of the folder you want to 
enlarge to zoom in and display the images inside that folder at a larger 
size.

Enlarge folders.

The folder you have double-clicked zooms in.

Double-
click on an 
empty part 
of the folder

To revert to the folder size before enlarging, click [ ] on the top 
of the window.

You can change the speed at which a folder zooms in (p.65).
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Changing the Display Magnification
If you have many images inside a folder and they are small and difficult 
to see, you can change the display magnification and display the 
images at a larger size.

Change the display magnification.

You can also change the display magnification by clicking [ ] 
or [ ].
The display magnification of the images changes.

The [Navigator] window appears and you can check and move 
the enlargement display position.
You can also move the enlargement display position by clicking 
[ ] on the top of the window and dragging over the window.
To return to full view, click [ ] on the top of the window.

Drag to the right

Navigator window

Enlargement 
display position
Drag to move the 
enlargement 
display position

1 Double-click an image to enlarge.

The viewer window appears.

Enlarging and Viewing Images One at a Time

Double-click
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2 Click [ ] or [ ] to switch to the image you want to 
display.

The shooting information is displayed by clicking [ ] on the top 
of the window.
To exit the viewer window, click [ ] on the top right of the 
window.

Viewer window

The [Display Original Image] button appears at the bottom of the 
window. Click this button to display the processed image.

When you display RAW images in the viewer window

For a list of viewer window functions, refer to p.74.

Displaying an Image Across the Whole Window (Full View Display)
Double-click on the image you want to display 
across the whole window.

You can also display the image across the whole window by 
clicking [ ] on the top of the window.
The image is enlarged and displayed across the whole window.

To return to the viewer window, click on the window or press the 
< Esc > key on the keyboard.

Double-click
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Printing an Image
This section explains how to print with Canon inkjet printers as well as 
with other types of printers.

If you have a PIXMA/BJ printer that is compatible with the Easy-
PhotoPrint (hereinafter, “EPP”) software for Canon printers, you can 
start up EPP from within ZB and easily perform high-quality photo 
printing. To perform this printing, it is necessary to first install EPP 
version 3.6 or later on your computer.

1 Select the image to be printed.

To select multiple images, click on the images while holding 
down the < Ctrl > key on the keyboard.
You can select all the images inside a folder by clicking on an 
empty part of the folder.

Photo Printing with Canon Inkjet Printers

Click

2 Start up EPP.
Click the buttons [Print]  [Easy-PhotoPrint].

EPP starts up.

3 Specify the number of copies to be printed and then 
click [Next].
Easy-PhotoPrint

Click to increase the number of copies to be printed
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4 Specify the paper size and then click [Next]. 5 Specify the layout and then click [Print].

Printing begins.

Click to print
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You can print one image on one sheet of paper.
If the Canon printing software Easy-PhotoPrint (hereinafter, “EPP”) is 
installed, performing step 2 starts up EPP. To cancel, see  on the 
next page.

1 Select the image to be printed.

To select multiple images, click on the images while holding 
down the < Ctrl > key on the keyboard.
You can select all the images inside a folder by clicking on an 
empty part of the folder.

Photo Printing with a Printer other than Canon Inkjet Printers

Click

2 Display the print settings window.
Click the buttons [Print]  [One Photo per Page Print].

The [One Photo per Page Print] window appears.

3 Set the paper type and size, and then click the [Print] 
button.

Printing begins.

One Photo per Page Print window
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If EPP is installed and you perform step 2, EPP starts up and the 
window for step 3 does not appear. If you want to prevent EPP from 
starting up with the procedure in step 2, select the [Tools] menu  
[Preferences], and in the [Printing] tab sheet, select [Use the Print 
Function in ZoomBrowser EX] (p.67).

Using the one photo printing function of ZB without using 
EPP

For a list of one photo per page print window functions, refer to p.75.

Exiting ZB
In the main window, select the [File] menu  [Exit].

ZB exits.
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Advanced Operation
This chapter explains more advanced operations such as efficiently 
checking, sorting and organizing images, performing general editing of 
images and utilizing your images.

Checking/Sorting Images ......................................... 18
Enlarging and Checking Images One at a Time........  18

Enlarging a Specific Part of an Image ...................  19
Sorting Images...........................................................  19

Arranging Images in the Main Window .................... 20
Extracting Images You Want to Display (Filter 
Display) ...............................................................  20

Efficiently Checking/Sorting Images......................... 21
Organizing Images ................................................... 22

Creating a Folder for Saving Images.........................  22
Moving Images ..........................................................  23

Moving Images in Folders......................................  23
Changing Image File Names or Folder Names........  24
Deleting Images.........................................................  24

Deleting Folders.....................................................  25
Registering Frequently-Used Folders as Favorite 
Folders ....................................................................  25

Deleting Favorite Folders.......................................  26
Editing an Image ...................................................... 27

Automatic Adjustment Using ZB................................  27
Adjusting Brightness, Color and Contrast..................  29
Trimming an Image....................................................  30
Inserting Text into Images .........................................  31

Adjusting Sharpness................................................... 32
Correcting Red-Eye Automatically.............................. 33

Correcting Red-Eye Manually................................. 33
Utilizing Your Images...............................................  34

Viewing Images as a Slide Show ............................... 34
Sending an Image by E-Mail ...................................... 35
Creating Wallpaper from an Image............................. 37
Creating a Screen Saver from an Image.................... 38

Writing Images to a CD ...........................................  40
Printing Multiple Images on One Sheet of Paper 
(Index Printing) ...................................................... 41
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Checking/Sorting Images
You can enlarge images one at a time from a list in the main window and 
check what they look like in detail, and sort them into one of three 
groups with [ ] (ratings).

1 Double-click on the image on the top left of the main 
window.

The viewer window appears.

Enlarging and Checking Images One at a Time

Double-click

2 Click [ ] or [ ] to switch to the image you want to 
display.

The shooting information is displayed by clicking [ ] on the top 
of the window.
To exit the viewer window, click [ ] on the top right of the 
window.

Viewer window

Select multiple images in the main window (p.9) and then click on 
[ ] on the top left of the main window (p.71) to display only the 
selected images in the viewer window.

To display only selected images in the viewer window

For a list of viewer window functions, refer to p.74.
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Enlarging a Specific Part of an Image

1 Enlarge an image.

You can also change the display magnification by clicking [ ] 
or [ ].
The image enlarges and the [Navigator] window appears.

2 Display the part of the image you want to check.
Drag the enlargement display position in the [Navigator] window 
and display the part of the image you want to check.

You can also move the enlargement display position by clicking 
[ ] on the top left of the window and dragging over the window.
To return to full view, click [ ] on the top left of the window.

Drag to the right

Navigator window

Enlargement 
display position
Drag to move the 
enlargement 
display position

Enlargement ratio

RAW images cannot be enlarged before they are processed. By clicking 
the [Display Original Image] button on the bottom of the window, the 
image is processed and it can be enlarged.

Enlarging RAW images

You can sort images into one of three groups by attaching [ ] (ratings) 
according to photo subject or theme. Please note that [ ] is 
automatically attached to images shot with your camera.

Increase or decrease a rating.

Sorting Images

Click to increase
Click to decrease
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Arranging Images in the Main Window
You can arrange images in order of how many [ ] you have attached 
to it (ratings), or according to the image’s shooting date and time.

Select the [View] menu  [Sort by]  desired item.

The images are arranged in the order according to the selected 
item.

Sort item Description
Star Rating Images are arranged in the order of the least number of [ ].
Name Image file names are arranged in the order of 0 – 9  a – z.
Shooting Date Images are arranged in the order of most recently shot.
Modification Date Images are arranged in the order of most recently updated.
Type Images are arranged in the order of BMP images  

RAW images  JPEG images  TIFF images.

Ascending Images are arranged from top to bottom in order of sorting criteria.
Descending Images are arranged from bottom to top in order of sorting criteria.

Extracting Images You Want to Display (Filter 
Display)
You can extract images displayed in the main window by the number of 
[ ] you have attached to them (ratings).

1 Click the [ ] button.

The extract function appears.

2 Checkmark the number of [ ] you want to extract 
and display.

Only the images with the number of [ ] you have checkmarked 
are displayed in the main window.
To exit the extract display, click the [ ] button again.
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Efficiently Checking/Sorting Images
With Preview Mode that displays images as thumbnails and as single 
images in the same window, you can sort images by the number of 
[ ] while checking efficiently. You can also simultaneously check 
shooting information for images.

1 Enable Preview Mode.

The main window display switches to Preview Mode.
Click

2 Click the [ ] or the [ ] button 
to switch to the image you want to check, and then 
sort with the number of [ ].

You can also click on the image in the thumbnail image display 
area to display the image enlarged in the center of the window.

The selected image is enlarged in the center of the window

Thumbnail image display area

Click to increase or decrease

You can double-click the folder icon to display the images in the folder in 
the thumbnail image display area.

When a folder icon appears in the thumbnail image display area

For a list of Preview Mode functions, refer to p.73.
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Organizing Images
This section explains functions that are useful for organizing images 
such as creating new folders for saving sorted images, moving and 
copying images and deleting unwanted images.

You can create a folder to save sorted images.

1 In the folder area, select the location where the new 
folder is to be created.

Creating a Folder for Saving Images

2 Select the [File] menu  [New Folder].

The [New Folder] dialog box appears.

3 Enter a folder name and click the [OK] button.
The new folder is created in the folder selected in step 1.
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You can move or copy images to separate folders and organize them 
according to shot date or theme.

Drag the image to be moved or copied.
To move:Drag the image and release when the image is in the 

destination folder.
To copy: Drag the image while holding down the < Ctrl > key and 

release when the image is in the destination folder.

The image is moved or copied to the folder it was dragged to.

Moving Images

Drag an image in the main window to a folder in the folder area on the 
bottom left of the window in the same way as described above to move 
or copy the image.

Moving images to a folder in the folder area

Moving Images in Folders
You can move or copy folders that contain images, and organize images 
in folders.

Drag the folder to be moved or copied.
To move:Drag the folder and release when the folder is in the 

destination folder.
To copy: Drag the folder while holding down the < Ctrl > key and 

release when the folder is in the destination folder.

The folder is moved or copied to the folder it was dragged to.

Drag a folder in the main window to a folder in the folder area on the 
bottom left of the window in the same way as described above to move 
or copy a folder.

Moving folders in the folder area
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1 Select the image whose name you want to change in 
the main window, or select the folder whose name 
you want to change in the folder area.

2 Select the [File] menu  [Rename].

The [Rename Image] or [Rename Folder] dialog box appears.

3 Enter the file name or folder name and then click the 
[OK] button.

The file name or folder name changes to the new name.

Changing Image File Names or Folder Names

You can also change file names or folder names in the properties 
window (p.46).

Please take care as deleted images cannot be recovered.

1 Select the unwanted image in the main window.

2 Click [Delete].

The [Confirm File Delete] dialog box appears.

3 Click the [Yes] button.
The image is moved to the [Recycle Bin] and is deleted from ZB.
Right-click [Recycle Bin] on the desktop and select [Empty 
Recycle Bin] from the menu that appears to delete the image 
from your computer.

Deleting Images

Click
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Deleting Folders
Deleted folders cannot be recovered. Please take care as all images 
inside folders are also deleted.

1 In the folder area, select the folder you want to 
delete.

2 Select the [File] menu  [Delete].

The folder is moved to the [Recycle Bin] and is deleted from ZB.
Right-click [Recycle Bin] on the desktop and select [Empty 
Recycle Bin] from the menu that appears to delete the folder 
from your computer.

You can register shortcuts for frequently-used folders in the [Favorite 
Folders] tab sheet in the folder area to make images easier to find.
Please note that because the [My Pictures] folder is registered as a 
favorite folder by default, the folder icon appears as [ ].

1 Select the folder you want to register.

2 Click the [Add to Favorites] button to register the 
folder.

The folder icon changes to [ ] and is registered as a favorite 
folder.

Registering Frequently-Used Folders as Favorite Folders
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3 Select the [Favorite Folders] tab sheet.

4 Select the registered folder to display the images 
inside the folder.

The images inside the folder appear.

Click

Any changes done to images inside registered folders will be applied to 
the original images. Therefore, please be aware that by editing or 
deleting images inside registered folders, you are in fact editing or 
deleting the original images.

If you have edited or deleted images in folders you have 
registered as favorites

Deleting Favorite Folders
If you no longer need a folder you have registered in the [Favorite 
Folders] tab sheet, you can delete it from this tab sheet.
Please note that as registered folders are shortcuts, the original folder 
will not be deleted when you delete the shortcut.

In the [Favorite Folders] tab sheet, select the folder 
you want to delete and then click the [Remove] 
button.

The folder is deleted.
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Editing an Image
If the brightness or color of images is different from what you visualized 
when you shot the photo, you can adjust an image using the editing 
functions to bring them closer to what you visualized.
This section explains about automatic adjustment of images, adjustment 
of brightness, saturation and contrast, trimming images, inserting text 
into images, adjustment of sharpness and red-eye correction.
JPEG images deteriorate slightly when edited and saved, and the image 
before editing cannot be recovered. For this reason, an edited JPEG 
image should be saved as a separate image from the original image.
Chapter 3 explains about high-level editing functions other than those 
described above and adjustment of RAW images.

The brightness and colors, etc. of the image are automatically adjusted.

1 Select the image you want to edit.

2 Click the buttons [Edit]  [Edit Image].

The [Edit Image] window appears.

Automatic Adjustment Using ZB

3 Select the buttons [Auto Adjustment]  [Finish].

The [Auto Adjustment] window appears.

Edit Image window
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4 Click the [Auto Adjust Image] button to adjust the 
image.

The image is adjusted.

5 Enlarge the window and check the adjustments.

In enlarged view, the [Navigator] window appears and you can 
check and move the enlargement display position.

Auto Adjustment window

Drag right to enlarge
Fits the image to the window size

Moves the enlargement display position
Zooms in/Zooms out

To revert to full view, click [ ] on the bottom left of the window.

6 Click the [Save As] button and save as a separate 
image.

The [Save As] window appears.

7 Specify the save destination and then click the 
[Save] button.

The edited image is saved as a separate image from the original 
image.

Window in enlarged display

Enlargement display position
Drag to move the enlargement display position



29

1
2
3
4

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Index

You can adjust the brightness, saturation and contrast of images.

1 Select the image you want to edit and display the 
[Edit Image] window (p.27).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.

The [Color/Brightness Adjustment] window appears.

3 Adjust the image.

Move the slider to the right to make the [Brightness] of an image 
appear brighter, the [Saturation] to appear more vivid and the 
[Contrast] stronger. Move the slider to the left to make the image 
appear darker, and the saturation and the contrast weaker.
The image is adjusted.

Adjusting Brightness, Color and Contrast

Drag to the left or right to adjust
Color/Brightness Adjustment window

4 Enlarge the window and check the adjustments (p.28).

5 Click the [Save As] button and save as a separate 
image (p.28).
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You can trim only the part of an image you need, or change the 
composition of an image where an image shot horizontally becomes 
vertical.

1 Select the image you want to edit and display the 
[Edit Image] window (p.27).

2 Select [Trim] and then click the [Finish] button.
The [Trim Image] window appears.

3 Drag the trimming range.

The trimming range can be moved by dragging.
You can change the trimming range by dragging the four corners 
and the four sides of the trimming range.

Trimming an Image

Trim Image window

Drag

4 Click the [Trim Image] button to trim the image.

The image is trimmed.

5 Click the [Save As] button and save as a separate 
image (p.28).
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You can insert the date and time you shot an image and text into an 
image as text.

1 Select the image you want to edit and display the 
[Edit Image] window (p.27).

2 Select [Insert Text] and then click the [Finish] button.
The [Insert Text] window appears.

3 Drag the range for inserting text.

The text insertion range can be moved by dragging.
You can change the text insertion range by dragging the four 
corners and the four sides of the text insertion range.

Inserting Text into Images

Insert Text window

Drag

4 Using the keyboard, enter the text you want to insert.

The text you enter appears in the window.

5 Click the [Save As] button and save as a separate 
image (p.28).
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You can make the overall atmosphere of an image harder or softer.

1 Select the image you want to edit and display the 
[Edit Image] window (p.27).

2 Select [Sharpness] and then click the [Finish] button.
The [Sharpness] window appears.

3 Adjust the image.

Move the slider to the right to make an image harder and to the 
left to make an image softer.
The image is adjusted.

Adjusting Sharpness

Sharpness window
Drag right to adjust

4 Enlarge the window and check the adjustments (p.28).

5 Click the [Save As] button and save as a separate 
image (p.28).
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You can automatically detect and correct red-eye that occurs when you 
photograph people using a flash.

1 Select the image you want to edit and display the 
[Edit Image] window (p.27).

2 Select [Red Eye Correction] and then click the 
[Finish] button.

The [Red Eye Correction] window appears.

3 Click the [Start] button to correct.

The image is corrected.

4 Click the [Save As] button and save as a separate 
image (p.28).

Correcting Red-Eye Automatically

Red Eye Correction window

Correcting Red-Eye Manually
You can manually correct red-eye that cannot be corrected automatically.

1 Display the [Red Eye Correction] window (Description 
on the left).

2 Enlarge the image (p.28).

3 Select [Manual Mode] and then click [ ].

4 Click on the places in the image you want to correct.
When you move the mouse cursor on the places to be corrected, 
[ ] is displayed.

The image is corrected.

5 Click the [Save As] button and save as a separate 
image (p.28).

Click
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Utilizing Your Images
You can view your images as a slide show, send them in an e-mail or 
use them as wallpaper or screen savers for your computer.

You can display selected images across the whole window and switch 
between them as a slide show.

1 Select images.

2 Click [Slide Show].

The [View as a Slide Show] window appears.

Viewing Images as a Slide Show

3 Set the slide show style and then click the [Finish] 
button.

The Slide Show window appears and the slide show begins.

View as a Slide Show window
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*1 The image is selected for printing. When the slide show ends and 
returns to the main window, the print dialog box is displayed.

*2 The image is selected. When the slide show ends and returns to 
the main window, the image is displayed as being selected.
When all the images have been displayed, the Slide Show 
window closes and returns to the main window.
To end the slide show half-way through, click [ ].

Slide Show window

File name Rating setting
Selects the image*2

Prints the image*1

Switches to the previous image
Pauses the slide show
Switches to the next image
Ends the slide show

You can attach a selected image to an e-mail and send it.
The image to be sent is a copy of the original image and therefore the 
original image remains unaffected on your computer.
Please note that the e-mail software for attaching and sending an image 
selected in ZB is MAPI-compatible software (p.36). Please consult the 
Instruction Manual for your e-mail software for settings related to MAPI.

1 Select an image.

2 Click the buttons [Internet]  [Email Images].

The [Email Images] window appears.

Sending an Image by E-Mail
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3 Select [Resize and compress images into JPEG 
type], set the image size and then click the [Next] 
button.

If the file is too large, you may not be able to send it attached to 
an e-mail. We recommend that you keep the size of images to 
300KB or smaller.
The settings window appears.

Checks the image size

Checks the image quality

Email Images window

4 Check that [Create a new email] is selected and then 
click the [Finish] button.

Your e-mail software starts up and the image is attached to an e-
mail.
Enter the address and a message and send the e-mail.

1 In step 4, select [Save the images in a folder to send through an email 
program that does not support MAPI] and save the image you want to 
attach.

2 Start up your e-mail software and select the saved image as an 
attachment.

Are you using e-mail software that is not MAPI-compatible?

MAPI - an acronym for Messaging Application Program Interface – 
is a Microsoft standard that allows the use of the sending and 
receiving functions of e-mail software from various software.
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You can make a selected image wallpaper for your computer.
The bitmap image for the wallpaper (extension “.BMP”) is created using 
a copy of an image and therefore the original image remains unaffected.

1 Select an image.

2 Click the buttons [Export]  [Export as a Wallpaper].

The [Export as a Wallpaper] window appears.

Creating Wallpaper from an Image 3 Specify the layout and the save destination for the 
wallpaper, and then click the [Finish] button.

The image you selected for your wallpaper is applied as 
wallpaper.
The image you selected for your wallpaper is saved in the 
specified folder.

Export as a Wallpaper window

1 On the desktop, right-click with the mouse and in the menu that 
appears, select [Properties].

2 Select the [Desktop] tab sheet.
3 Select the file to become the wallpaper and then click the [OK] button.

To revert to the original wallpaper
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You can make a selected image a screen saver for your computer.
The data for the screen saver (extension “.SCR”) is created using a 
copy of an image and therefore the original image remains unaffected.

1 Select an image.

2 Click the buttons [Export]  [Export as a Screen 
Saver].

The [Export as a Screen Saver] window appears.

Creating a Screen Saver from an Image 3 Checkmark [Include images in the screen saver], 
specify a save destination and then click the [Finish] 
button.

The data for the screen saver is saved in the specified folder.

Export as a Screen Saver window
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4 Specify the saved screen saver on your computer.
On the desktop, right-click with the mouse and in the menu that 
appears, select [Properties]. Display the [Screen Saver] tab 
sheet in the [Display Properties] dialog box.

Applies the selected screen saver data
Select the saved screen saver data

When you checkmark [Include images in the screen saver] in step 3, the 
original image is copied to create the data for the screen saver. This 
means that even if the original image is deleted or the file name is 
changed, it does not affect the screen saver. However, if you remove the 
check mark, the data is created using the original image, and if the 
original image is deleted or the file name is changed, the screen saver 
will not work properly.

About the [Include images in the screen saver] checkbox
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Writing Images to a CD
You can write selected images to a CD.
This function is only compatible with a computer that has Windows Vista 
or Windows XP preinstalled and is equipped with a standard CD-R/RW 
drive.

1 Insert a CD-R/RW disk in the CD-R/RW drive.
When the dialog box below appears, select the [Cancel] to close 
the dialog box.

2 Select the images you want to write to the CD.

3 Click the buttons [Export]  [Backup to CD].

The [Backup to CD] window appears.

4 Specify the settings for writing to the CD-R/RW disk 
and then click the [Finish] button.

Writing to the CD-R/RW begins.

Backup to CD window
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Printing Multiple Images on One Sheet of Paper (Index Printing)
You can arrange multiple images in index format and print them on one 
sheet of paper.

1 Select the images.

2 Click the buttons [Print]  [Index Print].

The [Index Print] window appears.

3 Specify settings such as the paper type and the 
number of prints, and then click the [Print] button.

Printing begins.

Print preview
Index Print window

For a list of index print window functions, refer to p.76.
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Using High-Level Functions
This chapter explains more advanced high-level functions than those 
described in Chapter 2.

Comparing Multiple Images ..................................... 43
Listing Images by Folder Level ................................ 44

Changing the Levels of the Displayed Folders ..........  45
Viewing Shooting Information for an Image ............. 46
Changing the Size and Type of an Image and 
Saving ..............................................................  47
Exporting Shooting Information.............................  48
Organizing Images Using High-Level Functions ...  49

Setting Keywords in Images ......................................  49
Entering Comments into Images ...............................  49
Saving Multiple Images with New File Names...........  50
Classifying Images by Shot Date .................................. 51

Searching for Images............................................  52
Performing Advanced Editing................................  53

Adjusting the Color of an Image in RGB....................  53
Adjusting the Brightness Level ..................................  54
Adjusting the Tone Curve ..........................................  54
Unsharpening an Image ............................................  55
Transferring Images to Other Image Editing Software...  56
Merging Images to Create Panorama Images...........  56

Adjusting RAW Images.......................................... 58
List of RAW Image Task Main Window Functions ...  60
List of Image Quality Adjustment Window 
Functions ........................................................  61

White Balance Files and Tone Curve Files for the 
EOS-1D Series Cameras ......................................  62

Saving White Balance Files.................................... 62
Saving Tone Curve Files (Excludes the EOS-1D 
Mark III) .............................................................  62

Adding Sound to Images/Playing Back .................. 63
Adding Sound to Images ............................................ 63
Playing Back Sound ................................................... 63

Printing Using Other Printing Software .................. 63
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Comparing Multiple Images
To compare multiple images, you can split the viewer window into two, 
three or four and display multiple images at the same time.
You can also align the display position of enlarged images and compare.

1 In the main window, select the images you want to 
compare (p.9).

2 Click [ ] (p.71).
The viewer window appears.

3 Select the number of images you want to display at 
the same time.

The viewer window is split and the multiple images are displayed 
at the same time.

Example of display when [ ] is clicked.

4 Click [Synchronize] and then enlarge the image.

The synchronize display appears and all the images are 
displayed at the same display magnification and in the same 
position.
The [Navigator] window that displays the enlargement display 
position appears and you can check and move the enlargement 
display position (p.19).
Click [Synchronize] again to cancel the synchronize display. You 
can now change the display magnification and move the 
enlargement display position for each image.
To return to full view, click [ ] on the top left of each window.
To cancel the split display, click [ ] at the top of the window.

Drag right to change the display magnification

Click
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Listing Images by Folder Level
You can switch the main window display to Scroll Mode that displays in 
folder levels and simultaneously view multiple folders and images inside 
the folders.

1 Click the [Scroll Mode] tab sheet.

The display in the main window switches to Scroll Mode.

2 Check the images inside the folders.

The images inside the folder are displayed.

Click Number of images inside the folder 
and number of folders

For a list of Scroll Mode window functions, refer to p.72.
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You can set the level to which images and folders are displayed in the 
window, which makes looking for the folders and images you want 
easier.

1 Select the [Tools] menu  [Preferences].
The [Preferences] window appears.

2 Change the depth of the folder level to be displayed.

Changing the Levels of the Displayed Folders

Folders up to the third level and images inside the folders are 
displayed in the window.
Folders at or higher than the fourth level are displayed as folder 
icons. Double-click these folders to display images and folders 
inside the folders.

Example of display when you have made the setting [3]
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Viewing Shooting Information for an Image
1 Enable Zoom Mode (p.71) or Scroll Mode (p.72).

2 Select the image for which you want to view the 
information.

3 Click [Properties].

The [Properties] window (image information window) appears.

Properties window

In Preview Mode, the same information as the [Properties] window 
is displayed on the information display area (p.73).
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Changing the Size and Type of an Image and Saving
You can change the size of an image or convert it to a TIFF image 
(extension “.TIFF”) or a bitmap image (extension “.BMP”) and save it. 
Because the image is saved as a separate image, the original image 
remains unaffected.

1 Select an image.

2 Click the buttons [Export]  [Export Still Images].

The [Export Still Images] window appears.

3 Specify the image size, type and save destination, 
and then click the [Finish] button.

The image is saved as an image separate from the original 
image.
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Exporting Shooting Information
You can export as a text file the shooting information recorded to the 
image.

1 Select an image.

2 Click the buttons [Export]  [Export Shooting 
Properties].

The [Export Shooting Properties] window appears.

3 Specify the export shooting information and save 
destination, and then click the [Finish] button.

The shooting information is saved as a text file (extension 
“.TXT”).
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Organizing Images Using High-Level Functions
You can organize images using high-level functions such as setting 
keywords and entering comments, renaming multiple files in a single 
operation and classifying images by shot year/month/date, all of which 
are useful when organizing your images.

You can set keywords to identify images. The set keywords are also 
useful when searching for images (p.52).

1 Display the [Properties] window (p.46).

2 Click the [ ] button in [Keywords] and then click 
the [View/Modify Keywords].

The [View/Modify Keywords] dialog box appears.

3 Select the keyword(s) and then click the [OK] button.

The keyword is set in the image.

Setting Keywords in Images

You can enter information relating to images as comments. The entered 
comments are also useful when searching for images (p.52).

1 Display the [Properties] window (p.46).

2 Click the [ ] button in [Comment].
A field for entering comments is displayed.

3 Enter text and then press the < Enter > key on the 
keyboard.

The entered text is saved in the image.

Entering Comments into Images
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You can copy multiple images and save them with new file names in a 
single operation.

1 Select all the images you want to save with new file 
names (p.9).

2 Click the buttons [View & Classify]  [Rename 
Multiple Files].

The [Rename Multiple Files] window appears.

Saving Multiple Images with New File Names 3 Checkmark [Make copies of files], specify the file 
name and then click the [Finish] button.

Images separate from the original images are saved with the new 
names.

In step 3, if you remove the check mark from [Make copies of files] 
in the window, please be aware that the file name for all the selected 
images including the original images changes.
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Multiple images can be classified into different folders according to shot 
date.

1 Select all the images to be classified (p.9).

2 Click the buttons [View & Classify]  [Classify into 
Folder].

The [Classify into Folder] window appears.

Classifying Images by Shot Date

Settings for Folder Structure

3 Specify the folder structure and save destination, 
and then click the [Finish] button.

Images are classified by shot date.

Setting Item Description
YearMonthDate Classifies images by creating a first-level folder 

according to shot year/month/date.
Year\YearMonthDate Classifies images by creating a second-level folder 

for the shot year, and the month and date.
Year\Month\
YearMonthDate

Classifies images by creating a third-level folder 
for the shot year, the month, and the date.
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Searching for Images
You can search for images by ratings (p.19), shot date, update, 
comments (p.49) and keywords (p.49).

1 Click the buttons [View & Classify]  [Search].

The [Search] window appears.

2 Specify the search criteria and then click the [Next] 
button.

The search begins and the images that match the criteria are displayed.

3 Click the [Finish] button to close the search results 
window.

The display returns to the main window.

4 Check the searched images in the main window.
The searched images are displayed as [Search Results] in the 
folder area in the main window. If you select this folder, the 
searched images are displayed.

The images inside the [Search Results] folder are stored until 
you either perform another search or exit ZB.
Any work you do on images inside the [Search Results] folder will 
be applied to all the original images. Therefore, please be aware 
that if you edit or delete images inside the [Search Results] 
folders, the original images will be edited or deleted also.
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Performing Advanced Editing
This section explains image editing using high-level functions based on 
the assumption that you are familiar with handling standard image 
editing software. 
JPEG images deteriorate slightly when edited and saved, and the image 
before editing cannot be recovered. For this reason, an edited JPEG 
image should be saved as a separate image from the original image.

You can adjust the color of an image in RGB (red, green, blue).

1 Select an image and display the [Edit Image] window 
(p.27).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.

The [Color/Brightness Adjustment] window appears.

3 From the list box, select [RGB Adjustment].

The window switches to the [RGB Adjustment] window.

Adjusting the Color of an Image in RGB 

4 Adjust the image.

The image is adjusted.

5 Click the [Save As] button and save as a separate 
image (p.28).

Drag to the left or right to adjust
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You can adjust the level of brightness (balance).

1 Select an image and display the [Edit Image] window 
(p.27).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.

The [Color/Brightness Adjustment] window appears.

3 From the list box (p.53), select [Level Adjustment].
The window switches to the [Level Adjustment] window.

4 Adjust the image.

The image is adjusted.

5 Click the [Save As] button and save as a separate 
image (p.28).

Adjusting the Brightness Level 

Drag to the left or right to adjust

You can adjust the brightness, contrast and color of a specific area by 
changing the tone curve.

1 Select an image and display the [Edit Image] window 
(p.27).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.

The [Color/Brightness Adjustment] window appears.

3 From the list box (p.53), select [Tone Curve 
Adjustment].

The window switches to the [Tone Curve Adjustment] window.

Adjusting the Tone Curve



55

1
2
3
4

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Index

4 Adjust the image.

The image is adjusted.
The horizontal axis shows the input level and the vertical axis 
shows the output level.
The maximum number of [ ] is 10.
To delete a [ ], either press the < Del > key or double-click on 
the [ ].

5 Click the [Save As] button and save as a separate 
image (p.28).

Click to add a [ ] (point)
Adjust by dragging [ ]

You can set amount, radius and threshold values and adjust sharpness.

1 Select an image and display the [Edit Image] window 
(p.27).

2 Select [Sharpness] and then click the [Finish] button.
The [Sharpness] window appears.

3 Select the [Unsharp Mask] tab sheet and adjust.

The image is adjusted.

4 Enlarge the window and check the adjustments (p.28).

5 Click the [Save As] button and save as a separate 
image (p.28).

Unsharpening an Image

Drag right to adjust
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You can transfer images to image editing software other than ZB.

1 Select an image and display the [Edit Image] window 
(p.27).

2 Select [Edit with external image editor].

3 Click the [Manage List] button and register the image 
editing software.

Select the image editing software in the window that appears.

4 In the [Edit with external image editor] list box, select 
the registered image editing software.

5 Click the [Finish] button.
The software selected in step 4 starts up and the image selected 
in step 1 is displayed.

Transferring Images to Other Image Editing Software
You can merge up to four JPEG images to create panorama images. 
For merging images, start up the image-merging software “PhotoStitch” 
from ZB and use.

1 Select multiple images to merge (p.9).

2 Click the buttons [Edit]  [Stitch Photos].

PhotoStitch starts up and the main window appears.

Merging Images to Create Panorama Images
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3 Check the arrangement of the images to be merged 
and click the [2. Merge] tab sheet.

If the arrangement of the images to be merged is not correct, 
drag the images to rearrange them.

The window switches to the [2. Merge] tab sheet.

4 Click [Start] to merge.

The images are merged and displayed.

5 Click the [3. Save] tab sheet.
The display switches to the [3. Save] tab sheet.
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6 Check the save range and then click [Save].

The [Save As] dialog box appears.

7 Specify the save destination and then click the 
[Save] button.

The merged images are saved.

8Select the [File] menu  [Exit] to exit.
PhotoStitch exits.

Save range
Drag [ ] to change the range

See also the Help that are displayed when you click [ ] on the 
right of the window for information on operating PhotoStitch and 
PhotoStitch functions.

Adjusting RAW Images
You can make the same adjustments (reset processing conditions) to 
RAW images as the functions that are available on the camera, such as 
brightness and white balance adjustment. You can also convert edited 
RAW images to JPEG or TIFF images and save them.
Because only the image processing conditions are changed when a 
RAW image is adjusted, the original image data remains totally 
unaffected. For this reason, image deterioration that usually 
accompanies editing does not occur and you can readjust, redo or undo 
changes knowing that you can always revert to the original shot 
condition of the image.

1 Select a RAW image.

2 Click the buttons [Edit]  [Process RAW Images].

RAW Image Task starts up and the main window appears.
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3 Adjust the image in the [Image Quality Adjustment] 
window.

The image is adjusted.
The adjustment items in the [Image Quality Adjustment] window 
vary according to the model of camera used for shooting the 
RAW image. For more details, refer to p.61.

4 Click [Save].

The [Save] dialog box appears.

RAW Image Task main window

Image Quality 
Adjustment 
window

5 Specify the type for the image to be saved and the 
save destination, and then click the [Save] button.

The processing dialog box appears and the JPEG image or TIFF 
image that has been converted from a RAW image is saved in 
the specified place. The RAW image remains unaffected.

6 Select the [File] menu  [Exit] to exit.
RAW Image Task exits.

See also [RAW Image Task Help] and the [Help] menu for 
information on operating RAW Image Task and RAW Image Task 
functions.
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List of RAW Image Task Main Window Functions

Sets a check mark
Selects/deselects the image

Shows/hides the shooting 
information

Shows/hides the [Image Quality Adjustment] window (p.61)
Rotates the image

Fit-to-window view
100% (actual pixel size) 
view
Enlargement/reduction 
ratio display
Enlargement/reduction 
display

Image display area

Cursor coordinates position and RGB value 
(8-bit conversion)

Displays the image selected in the 
thumbnail image display area

Thumbnail image 
display area

Switches between 
displayed images

Transfers the image to 
image editing software

Saves the image (p.59)

Cancels [ ], [ ] or [ ]
Zooms in

Zooms out
Moves the enlargement display position

Shows/hides the [Histogram] window
Shows/hides the [Navigator] window



61

1
2
3
4

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Index

List of Image Quality Adjustment Window 
Functions         
You can adjust RAW images (reset processing conditions) with the 
same functions available on the camera. Adjustment settings displayed 
in the [Image Quality Adjustment] window vary depending on the 
camera model used for shooting the RAW image.

The settings at the time of shooting are displayed in bold and 
italics in the list boxes.

Example of EOS-1D Mark III display

Brightness adjustment

Click white balance

Saves the set white balance 
as a white balance file

Loads a Picture Style file and 
applies it to the image

Applies and redisplays multiple 
adjustment settings in a single 
operation

Cancels all settings and reverts to the status 
at the time of shooting

Checkmark to redisplay for each adjustment made

1 Remove the check mark from [Preview].
2 Set multiple adjustment items.
3 Click the [Update] button.

All the adjustments are saved to the image and redisplayed in one 
operation.

You can apply the settings that have been adjusted in the [Image Quality 
Adjustment] window to another image by selecting the [Edit] menu  
[Development Conditions]  [Copy] or [Paste] in the RAW Image Task 
main window (p.60). You can also select [Save] or [Load] to save or 
download the settings as a separate file from the image (extension 
“.DVP”).

Applying multiple adjustment settings to an image at one 
time

Applying adjustment settings to another image

It takes approximately 1 to 3 seconds until the adjusted image is 
redisplayed (undergone development processing) (when using 
the following: OS: Windows XP; CPU: 2.2 GHz Pentium 4; RAM: 
512MB). However, the time it takes to redisplay an image varies 
greatly depending on the camera model used to shoot the image, 
computer type and the subject of the image.
A Picture Style file is an extended function of Picture Style. It is a 
file that offers effective image characteristics for an image shot in 
an extremely limited scene. For more details on Picture Style files, 
refer to the Canon’s web site.
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White balance and tone curve (excludes EOS-1D Mark III) adjustments 
made to RAW images of EOS-1D series cameras can be saved as a file 
as explained below and then registered to a camera and used.
For information on registering cameras, see the two related pages 
below in “Chapter 2: Setting the Camera from Your Computer” in the 
“EOS Utility Instruction Manual” (PDF electronic manual).

For details on white balance files, refer to “Registering Personal White 
Balance in the Camera”.
For details on tone curve files, refer to “Setting Parameters and 
Applying to the Camera”.

Saving White Balance Files

1 Adjust white balance in the [Image Quality 
Adjustment] window.

2 Click the [ ] button to save as a white balance file.
Click the [ ] button to save the adjusted white balance results 
as a white balance file (extension “.WBD”).

3 Use EOS Utility to register the saved file to the 
camera.

White Balance Files and Tone Curve Files for 
the EOS-1D Series Cameras

Saving Tone Curve Files (Excludes the EOS-
1D Mark III)

1 Click the [ ] button in the [Image Quality 
Adjustment] window and adjust the tone curve.

2 Click the [Save] button to save as a tone curve file.
Click the [Save] button in the [Tone Curve] dialog box to save the 
adjusted tone curve as a tone curve file (extension “.TCD”).

3 Use EOS Utility to register the saved file to the 
camera.

White balance files are not compatible with other camera models.
Tone curve files for the EOS-1Ds Mark II and the EOS-1D Mark II 
are compatible and tone curve files for the EOS-1Ds and the 
EOS-1D are compatible.
White balance files and tone curve files are compatible with 
Windows and Macintosh computers.
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Adding Sound to Images/Playing Back
You can add sound to images and play back sound which you have 
added to images with a camera that has a sound record function.

You can add WAVE sound files to images (extension “.WAV”).

You can play back sound files that are attached to images.

1 Select an image to which you want to add sound.

2 Select the [Edit] menu  [Add/Remove Sound].
The [Sound] dialog box appears.

3 Click the [Add] button and select the sound file to be 
added to the image.

Select a WAVE sound file.
The display returns to the [Sound] dialog box.

4 Click the [OK] button to close the dialog box.
The [ ] icon is displayed on images to which sound has been 
added.

1 Select an image to which a [ ] icon is attached.

2 Select the [Edit] menu  [Play Sound].
The sound is played back.

Adding Sound to Images

Playing Back Sound

Printing Using Other Printing Software
You can start up printing software installed on your computer from within 
ZB and print images.

1 Select an image you want to print.

2 Click the buttons [Print]  [Print Using Other 
Software].

The [Print Using Other Software] window appears.

3 Select the printing software and then click the 
[Launch] button.

The printing software starts up and the image you selected in 
step 1 is displayed.

4 Make the necessary settings in the printing software 
and print.

Printing software that is incompatible with ZB does not appear in the 
[Print Using Other Software] window and can therefore not be used to 
print.

Printing software does not appear
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Preferences
You can change any of the ZB functions in the preferences window, 
making them easier to use.

Preferences .............................................................  65
General Settings......................................................... 65
Selection Settings....................................................... 66
Rotation Settings ........................................................ 66
Printing Settings ......................................................... 67
Shooting Information Settings .................................... 67
Themes Settings......................................................... 68

Showing/Hiding Task Buttons..................................  68
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Preferences
You can change any of the ZB functions in the preferences window. 
Check the settings displayed for each window before making changes.
For detailed information on each function, click the [?] button on the 
bottom left of the preferences window and refer to the Help that is 
displayed.

1 Select the [Tools] menu  [Preferences].

2 Select the tab sheet to be set, make changes to the 
settings and then click the [OK] button.

You can make settings such as adjusting the minimum size of thumbnail 
images that are displayed in the main window, the speed of Zoom Mode 
(p.71), the levels of image and folder display in Scroll Mode (p.72) and 
color management. 

General Settings
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You can make settings related to image selection.

Selection Settings
You can make settings related to image rotation.

Rotation Settings
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If you have selected [One Photo per Page Print] (p.15), you can set 
whether to print in Easy-PhotoPrint (p.13) or to print with the ZB printing 
functions (p.15).

Printing Settings
You can set the information that is displayed when you click [ ] 
(shooting information display) in the viewer window (p.74).

Shooting Information Settings
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You can set the background color for the main window.

Themes Settings
Showing/Hiding Task Buttons
You can show or hide task buttons displayed on the left of the main 
window according to your requirements. Hiding buttons you do not use 
makes operating ZB easier.

1 Select the [Tools] menu  [Customize].
The [Customize] dialog box appears.

2 Remove the check mark from the buttons you want 
to hide.

3 Click the [OK] button to apply your changes.

4 Restart ZB for the settings to be applied.
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Reference
This reference section has been provided to enhance your experience 
using ZB.
It contains various troubleshooting solutions, how to delete ZB from your 
computer and explanations of the various windows’ functions.
An Index is provided at the end of the chapter for you to easily find 
information you are looking for.

Troubleshooting.......................................................  70
Deleting the Software (Uninstalling) ........................  70
List of Main Window Functions................................  71

Zoom Mode ................................................................ 71
Scroll Mode................................................................. 72
Preview Mode............................................................. 73

List of Viewer Window Functions.............................  74
List of One Photo per Page Print Window Functions...  75
List of Index Print Window Functions ......................  76
Index........................................................................  77

About This Instruction Manual ................................ 79
Trademark Acknowledgments ................................ 79
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Troubleshooting
If ZB is not operating correctly, refer to the items below.

You cannot install the software if a user setting other than [Computer 
administrator] privilege or [Administrator] privilege is selected. Select 
the [Computer administrator] privilege user setting in Windows XP or 
the [Administrator] privilege user setting in Windows 2000. For 
detailed information on selecting the user setting, refer to your 
computer User’s Manual.

ZB does not operate correctly on a computer if its system 
requirements does not meet. Use ZB on a computer with compatible 
system requirements (p.2).
Even if your computer has the RAM capacity (memory) described in 
the system requirements (p.2), if other applications are running at the 
same time as ZB, you may not have sufficient RAM (memory). Exit 
any applications other than ZB.

Images that are not supported by ZB (p.2) do not display. There are 
various types of JPEG and TIFF images, so JPEG images other than 
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif 
compatible images may not display properly.
With initial settings, the color of images that have been shot in Adobe 
RGB appear weak. In this case, check the [General] tab sheet in 
preferences and checkmark [Adjust color of images using monitor 
profile] (p.65). Color management is performed and the color of the 
image shot with an Adobe RGB setting and the image shot with an 
sRGB setting are matched.

Installation could not be completed correctly

ZB does not work

Images do not display properly

Deleting the Software (Uninstalling)
Exit any applications before uninstalling the software.
Log in under the Computer administrator/Administrator privileges 
when uninstalling the software.
To prevent computer malfunctions, always restart your computer after 
you have uninstalled the software. Re-installing the software without 
first restarting your computer is particularly likely to result in computer 
malfunctions.

1 Select the [Start] button  [All Programs] 
([Programs] in Windows 2000)  [Canon Utilities]  
[ZoomBrowser EX]  [ZoomBrowser EX Uninstall].

2 Proceed with the uninstallation as directed by the 
on-screen messages.

The software is uninstalled. 
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List of Main Window Functions
Zoom Mode

Folder path

Display magnification (p.11)
Filter display (p.20)
Reduction display (p.11)
Enlargement display (p.11)
Cancels [ ], [ ] or [ ]
Shows/hides the image or 
folder information
Selects/deselects all the 
images or folders
Displays the folder one level 
above
Returns to the display of the 
folder before [ ] is clicked
Returns to the display of the 
folder previously displayed

Image display area

Bracketing iconProtect icon Audio recording icon

Number of selected images

RAW image iconShows/hides the task buttons and folder area

*1 Images in folders and folders selected here are displayed on the image display area.

Shows/hides 
the task buttons

Task buttons

Folder area*1

Viewer window (p.74)

Properties window (p.46)
Slide show (p.34)

Image search (p.52) Deletes images/folders (p.24, p.25)
Rotates an image (p.9)

Moves the enlargement display position (p.11)

Full view (p.11)
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Scroll Mode

Folder path

Display magnification (p.11)
Filter display (p.20)
Shows/hides the image or 
folder information
Selects/deselects all the 
images or folders
Displays the folder one level 
above
Returns to the display of the 
folder before [ ] is clicked
Returns to the display of the 
folder previously displayed

Image display area

Number of selected imagesShows/hides the task buttons and folder area

*1 Images in folders and folders selected here are displayed on the image display area.

Task buttons

Viewer window (p.74)

Properties window (p.46)
Slide show (p.34)

Image search (p.52) Deletes images/folders (p.24, p.25)
Rotates an image (p.9)

Shows/hides 
the task buttons

Folder area*1
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Preview Mode

Folder path

Filter display (p.20)

Shows/hides the image or 
folder information
Selects/deselects all the 
images or folders
Displays the folder one level 
above
Returns to the display of the 
folder before [ ] is clicked
Returns to the display of the 
folder previously displayed

Information display area

Number of selected images
Shows/hides the task buttons and folder area

*1 Images in folders and folders selected here are displayed on the 
thumbnail image display area.

*2 Images selected here are displayed on the image display area.

Task buttons

Viewer window (p.74)

Slide show (p.34)
Image display area

Rotates an image (p.9)

Shooting information (p.46)

Thumbnail image display 
area *2

Shows/hides the information display area
Switches between images

Deletes images/folders (p.24, p.25)
Image search (p.52)

Shows/hides 
the task buttons

Folder area*1
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List of Viewer Window Functions

Synchronize (p.43)
File name

Rating (p.19)
Full view display (p.12)

Folder path

Switches between 
images
Fit-to-window view 
(p.19)

100% (actual pixel 
size) view
Display magnification 
(p.19)

Enlargement display (p.19)

Reduction display (p.19)

Moves the enlargement display position (p.19)
Prints the image (p.15) Edits (p.27 to p.33, p.53 to p.56)

Shows/hides the AF point

Shows/hides the shooting information (p.12, p.18)

Split displays (p.43)
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List of One Photo per Page Print Window Functions

Layout settings

Trims the image

Print preview

Number of prints

Switches the printing image

Shot date and time 
printing

Printer selection and settings Rotates the image
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List of Index Print Window Functions

Layout settings

Print preview

Switches the printing page

Print information 
settings

Printer selection and settings
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Index
A
Adding Sound to Images.....................................................................  63
Adjust JPEG Images.....................................................................  27, 53
Adjust RAW Images............................................................................  58
Adjusting (JPEG or TIFF Image)...................................................  27, 53

Adjusting in RGB ..........................................................................  53
Adjusting the Brightness...............................................................  29
Adjusting the Brightness Level .....................................................  54
Adjusting the Contrast ..................................................................  29
Adjusting the Saturation ...............................................................  29
Adjusting the Sharpness ..............................................................  32
Adjusting the Tone Curve.............................................................  54
Automatic Adjustment ..................................................................  27
Correcting Red-eye ......................................................................  33
Unsharpening Mask .....................................................................  55

Adjusting (RAW image).......................................................................  58
Adjusting Color Saturation............................................................  61
Adjusting Color Tone....................................................................  61
Adjusting the Contrast ..................................................................  61
Adjusting the Sharpness ..............................................................  61
Adjusting White Balance ..............................................................  61
Click White Balance .....................................................................  61
Picture Style .................................................................................  61
Picture Style File ..........................................................................  61

Adjusting Images in RGB....................................................................  53
Adjusting the Brightness .....................................................................  29
Adjusting the Brightness Level............................................................  54
Adjusting the Contrast.........................................................................  29
Adjusting the Saturation......................................................................  29
Adjusting the Sharpness ...............................................................  32, 61
Adjusting the Tone Curve ...................................................................  54
Attach an Image to an E-mail..............................................................  35
Automatic Adjustment .........................................................................  27

B
Batch Change the File Name of Images .............................................  50

C
Change File Name..............................................................................  24

Change Folder Name .......................................................................... 24
Change the Display Magnification ....................................................... 11
Changing the Folder Level Settings .................................................... 45
Changing the Size and Type of an Image and Saving ........................ 47
Checking the Shooting Information ..................................................... 46
Classifying the Images by Shot Date................................................... 51
Click White Balance............................................................................. 61
Compare Multiple Images.................................................................... 43
Contrast ............................................................................................... 29
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About This Instruction Manual
It is prohibited to reproduce, in whole or part, the contents of this 
Instruction Manual without permission.
Canon may change without notice the software specifications and 
contents of this Instruction Manual.
The software screens and displays printed in this Instruction Manual 
may differ slightly from the actual software.
The content of this Instruction Manual has been reviewed thoroughly. 
However, if you should notice any errors or omissions, please contact 
a Canon Service Center.
Please note that irrespective of the above-mentioned, Canon does 
not take responsibility for the outcome of the operation of the 
software.

Trademark Acknowledgments
IBM is a registered trademark of International Business Machines 
Corporation.
Microsoft and Windows are registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries.
Other names and products not mentioned above may be registered 
trademarks or trademarks of their respective companies.
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